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Introduccién a PhoneGap

Introduccion

El desarrollo para aplicaciones moviles esta sufriendo estos Ultimos afios el mismo problema que existia en el desarrollo de
aplicaciones de escritorio antes de la aparicion de la plataforma Java (concepto de maquina virtual); esto es, que para hacer que
una misma aplicacién pudiera "correr" en distintos sistema operativos (imaginaos un juego) era necesario un gran esfuerzo
econodmico debido a las diferencias entre lenguajes, dispositivos etc... . La situacion en las aplicaciones moéviles hoy dia es
similar. Para hacer una aplicacion que basicamente funcione en Android y Iphone, ya necesito conocer dos lenguajes de
programacion diferentes, con entornos de desarrollo diferentes, con sistemas operativos diferentes, con posibilidades de
experiencia de usuario diferentes, etc... . Esto supone que el coste de desarrollo, mantenimiento y evolucién de una misma
aplicacion se vea casi multiplicado por el nimero de diferentes terminales a los que se quiere llegar: Android, iOS, Windows
Mobile, Blackberry, Palm, Symbian ..., vamos, la torre de babel.

Sin embargo, progresivamente en estos Ultimos afios se han alineado varios planetas para dar lugar a una arquitectura que puede
ordenar el caos que existe en este momento. Esos "planetas” son:

e HTMLS, CSS3 y JavaScript como plataforma base de desarrollo de las aplicaciones méviles

e Servicios Web (ya sean SOAP o Restful) como mecanismo de comunicacion entre la aplicacion cliente y el servidor

e La posibilidad de usar el navegador ("browser") embebido en la aplicaciéon movil (Webview) como plataforma de ejecucion
de nuestra aplicacion HT ML5/CSS3/JavaScript. Desde el navegador embebido ya es posible acceder a través de JavaScript
a las librerias nativas que permiten el acceso a los distintos dispositivos del terminal (acelerémetro, camara, GPS, etc...),
ya que todas las plataformas lo permiten (evidentemente, no todos los terminales disponen de todos esos dispositivos)

Alguno me dird: "Paco, pero ya seria la cafia que encima todas estas APls o interfaces de acceso a los dispositivos fuera la
misma". Pues si, seria "la cafia", pero no es asi, sin embargo ahi queria yo llegar. Este es justo el "hueco" que PhoneGap viene a
rellenar.

¢ Qué es PhoneGAP ?

Es un framework para desarrollar aplicaciones nativas usando HTML, CSS y Javascript (si, si, sin usar Java, ni ObjectiveC, ni
C++, ni C#, ni...). Las aplicaciones construidas usando este framework seran mitad nativas, mitad HTML5/JavaScript/CSS (Lo que
se ha venido a llamar aplicaciones hibridas). La parte nativa sera la que accede a las capacidades del terminal, mientras que el
interfaz de usuario, la logica de aplicacién y la comunicacién con el servidor sera la otra mitad. Y PhoneGap proporciona el
acceso "comun" a la parte nativa mediante un APl Javascript, haciendo transparente al programador la parte nativa. Con esto
cerrariamos el circulo, bueno casi, ya que aun sigue habiendo un pero. Algunos Smartphones/Tablets no disponen aun de la
suficiente capacidad para soportar las necesidades de estas aplicaciones hibridas (hablo de memoria, disco, procesador...).
Pero esto es so6lo cuestion de tiempo (he tenido un "deja vu'... no os suena esto a cuando salidé Java... que si es lento, que si C++,
que si tal, que si JIT Compiler, que si dos procesadores, que si cuatro, que si mas memoria, que si... es decir, el tiempo, uno, dos,
tres afios, quién sabe...).

Empezando con PhoneGAP en Android

Para poder hacer los ejemplos, por ahora necesitamos:

. Eclipse >=3.4

JDK 1.6

. Android SDK

. Plugin Android ADT para Eclipse (si no lo tenéis instalado, podéis hacerlo desde el eclipse en Help > Install New Software
desde el repositorio: "https://dl-ssl.google. com/android/eclipse”

AWM o

Os muestro en la imagen el Android SDK Manager para que veais las versiones que tengo instaladas:
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- Impulsores Comunidad JAyuda?

= 0 personas han traido clicks a esta pagina

sin clicks + + + + + + + +
powered by karmacracy Autor
OO0 Android SDK Manager
SDK Path: /Users/fimpaez/android-sdks/ » JBossESB y JBDS
- P“kiges » Apache Hadoop - HDFS
W' Name API Rev. Status
3| v(dTools ~ » Apache Hadoop-MapReduce
0 X Android SDK Tools 17 &installed )
O /¥4 Android SDK Platform-tools 11 Sinstalled » Apache Camel, primeros
O ¥ [l Android 4.0.3 (API 15) peses
() | Documentation for Android SDK 15 2 Binstalled » Patron Irtérprete
O /#' SDK Platform 15 3 Sinstalled
0 & samples for SDK 15 2 Apinstalled
O ‘' ARM EABI v7a System Image 15 1 &b installed
O ' Google APIs 15 1 & Not installed
) Sources for Android SDK 15 1 &b Installed Ultimas ofertas de
(] ¥ (] Android 4.0 (API 14) empleo
)] ‘' SDK Platform 14 3 & Installed
O & Samples for SDK 14 2 & Installed
O %' ARM EABI v7a System Image 14 2 & Installed 2011-00-08
()] ' Google APIs 14 2 § Not installed & Comercial - Ventas -
0 Sources for Android SDK 14 1 Sinstalled MADRID.
[ ¥ (] Android 3.2 (API 13) 2011-09-03
) ‘' SDK Platform 13 1 &P Installed & Comercial - Ventas -
()] & Samples for SDK 13 1 & nstalled VALENCIA.
O ' Google APIs 13 1 & Not installed ————
(@] ' XOOM2ME 13 1§ Notinstalled 4 Comercial - Compras -
)] ' XOOM2 13 1 & Not installed ALICANTE.
[0 ¥ [Z] Android 3.1 (API 12)
() ' SDK Platform 12 3 &b installed 2011-07-12
(@] & Samples for SDK 12 1 Sinstalled @0 Otras Sin catalogar -
(] ' Google APIs 12 1§ Notinstalled MADRID.
O ‘& Google TV Addon 12 2 ¥ Not compatible with Mac 0S X 2011-07-06
O 'ig. OpenSense SDK for Tablets 12 2 § Not installed {4 Otras Sin catalogar -
()| ¥ (] Android 3.0 (API 11) LUGO.
()] /i SDK Platform 11 2 &b installed
O & samples for SDK 11 1 installed
O ' Google APIs 11 1 § Not installed
)] g XOOM 11 2 & Not installed
[ ¥ [z Android 2.3.3 (API 10)
() " SDK Platform 10 2 & Installed
a & Samples for SDK 10 1 & Installed
)] ' Google APIs 10 2 & nstalled
O '#g. OpenSense SDK for Phones 10 2 & Not installed
O -i], Intel Atom x86 System Image 10 1 ‘ Not installed
O ' Dual Screen APIs 10 1 § Not installed
o ' Real3D 10 2§ Notinstalled
O g ADMIRAL 10 5 ¥ Notinstalled
O B ATRIX2 10 1 & Not installed
0 ', Bionic 10 2§ Not installed
O g defy+ 10 1 & Not installed
O ' Droid4 10 1 & Not installed
O ' DroidRAZR 10 4§ Notinstalled
O ' MotorolaPro+ 10 2 § Not installed
O g MT870 10 2§ Not installed
O @ MT917 10 1§ Notinstalled
O ' PHOTON 10 1 & Not installed
O " XT882 10 2§ Not installed
0 . XT928 10 1§ Notinstalled
O g EDK 2.0 10 1§ Notinstalled
()| ¥ (] Android 2.2 (API 8)
O ' SDK Platform 8 3 Binstalled
0O & samples for SDK 8 1 &installed

Como se supone que tenemos instalado el plug-in ADT, tendréis dos iconos relacionados con el plugin Android ADT:

Pulsad sobre el recuadrado en rojo para afiadir un nuevo dispositivo virtual (un simulador) y pulsad "New..." para crear un AVD
como el mostrado:
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Android Virtual Device Manager

List of existing Androiy () () ) Create new Android Virtual Device (AVD)

[AVD Name

= 1

~ A valid Android
X An Android Virti

wties | 4 Servers |8

:40 - SDK Manager]
:00 - SDK Manager]
:17 - SDK Manager]

Name: Android-2.2
Target: | Android 2.2 - API Level 8 H
CPU/ABI: ARM (armeabi) 44
SD Card:
(®) size: 128 [ miB $
O File: { Browse... )
Snapshot:
() Enabled
Skin:
@ Built-in: [ HVGA 4
O Resolution: x
Hardware:
Property Value

Abstracted LCD density 160
Max VM application heap si 24

Delete

/ABI

Edit...
Delete...

Repair...

Details...

Start...

_

VA

——

s, got 77 bytes.
s, got 77 bytes.
s, got 77 bytes.

["] Override the existing AVD with the same name

(" cancel ) |( Create AVD )

Ahora Unicamente nos falta descargarnos el SDK de PhoneGap. Lo haremos desde el sitio de PhoneGap. Pulsad en el incono
Download PhoneGap 1.5.0 (version del momento). Descomprimid el zip en algun lugar de vuestra maquina.

Ahora crearemos un nuevo proyecto en Eclipse: File > New Project > Android Project:

o0 0 New Android Project

Create Android Project
Select project name and type of project

Project Namezl FirstAndroidProject I
(%) Create new project in workspace
(O Create project from existing source

() Create project from existing sample

M Use default location

Location: /Users/fimpaez/workspace/FirstAndroidProject " Browse... )

Working sets

"] Add project to working sets

Working sets: 13) ( Sseleat.. )

@ ( <Back )[ Next > )l( Cancel ) (  Finish
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o OO

New Android Project

Select Build Target
Choose an SDK to target

Build Target
Vendor Platform APl Lev |
Android Open Source Project 2.2 8
Android 2.3.3 Android Open Source Project 233 10
) Google APIs Google Inc. 233 10
() Android 3.0 Android Open Source Project 3.0 11
() Android 3.1 Android Open Source Project 3.1 12
() Android 3.2 Android Open Source Project 3.2 13
() Android 4.0 Android Open Source Project 4.0 14
() Android 4.0.3 Android Open Source Project 4.03 15

Standard Android platform 2.2

@ ( < Back )[ Next > )l( Cancel ) Finish

o OO

New Android Project

Application Info

Configure the new Android Project

Application Name:  FirstApp

Package Name: com.autentia.adictos.phonegap.ejemplo

¥ Create Activity: FirstActivity

Minimum SDK: 8 (Android 2.2) v)

)

[ZT Create a Test Project

Test Project Name:  FirstAndroidProjectTest

Test Application: FirstAppTest

Test Package: com.autentia.adictos.phonegap.ejemplo.test

@ ( < Back ) Next > ( Cancel )[ Finish )l

Ahora debemos afiadir las libreria de PhoneGap al proyecto que acabamos de crear:

e Cread un directorio "libs" en el proyecto y copiad en él el fichero: "cordova-1.5.0.jar" que se encuentra en "lib > android" de
la distribucion de PhoneGap que habéis descomprimido.
o Afadir este "jar" al Build Path del proyecto:
VflgFirstAndroidProject
> @Bsrc
> GI@gen [Generated Java Files]
b =\ Android 2.2
» =), Android Dependencies
» =\, Referenced Libraries
V¥ = assets
v = www
cordova-1.5.0.js
index.html
¥ = bin
> (=res
|=| classes.dex
|=| FirstAndroidProject.apk
arlist.cache

£5 A0

—
v & libs
#» cordova-1.5.0.jar
V 5 res
» (= drawable-hdpi
» (= drawable-Idpi
» (= drawable-mdpi
¥ (= drawable-xhdpi
» (= layout
» (= values
¥ (= xml
|4 cordova.xml
a1 plugins.xml
| AndroidManifest.xml
proguard-project.txt
project.properties

e Cread un directorio llamado "assets" y dentro otro llamado "www" en el proyecto. En este subdirectorio "www" copiad el
fichero "cordova-1.5.0.js" que se encuentra en "lib > android" de la distribucion de PhoneGap que habéis descomprimido.

e Copiad el directorio "xml" que se encuentra en "lib > android” de la distribucion de PhoneGap que habéis descomprimido, en
el directorio "res" del proyecto.

Os debe quedar asi:
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v ;; FirstAndroidProject

> (Bsrc

» =2 gen [Generated Java Files]
b = Android 2.2

» =) Android Dependencies

b =), Referenced Libraries

¥ > assets

v = www
[&) cordova-1.5.0.js
[£] index.html
¥ =>bin
> S res
|=| classes.dex
|=| FirstAndroidProject.apk
|=| jarlist.cache

LESOULCRS. AN,

v &= libs

#» cordova-1.5.0.jar
V= res
» (= drawable-hdpi
P (= drawable-Ildpi
» (= drawable-mdpi
¥ (= drawable-xhdpi
» (= layout
P (= values
¥ (= xml

<l cordova.xml|

/<1 plugins.xml|
£ AndroidManifest.xml
EJ proguard-project.txt
[Z] project.properties

Con estos pasos ya tenemos instalado lo necesario para poder usar PhoneGap. Ahora tan sélo nos faltan algunos detalles de
configuracién. Editad el fichero "AndroidManifest. xml" para:

o Afadir los permisos necesarios (todos los que necesita PhoneGap. Si nuestra aplicacion no necesita ciertos elementos,
podemos quitarlos.). Yo voy a darle todos los permisos

o Definir los tamafios de pantalla que soporta mi aplicacion (todo que si)

o Afadir a la actividad la configuracién necesaria para indicar que no es necesario recrear la actividad cuando rotamos la
pantalla.

o Afadir una segunda actividad necesaria para configurar PhoneGap. En Android, una actividad representa una pantalla

Finalmente, el fichero os ha de quedar:

view plain  print ?

<?xml version="1.0" encoding="utf-8"?>

<manifest xmlns:android="http://schemas.android.com/apk/res/android"
package="com.autentia.adictos.phonegap.ejemplo"
android:versionCode="1"
android:versionName="1.0" >

<!-- Tamahos de pantalla soportados -->

<supports-screens
android:anyDensity="true"
android:largeScreens="true"
android:normalScreens="true"
android:resizeable="true"
android:smallScreens="true" />

<!-- Permisos de la aplicacidn -->

<uses-permission android:name="android.permission.CAMERA" />
<uses-permission android:name="android.permission.VIBRATE" />
<uses-permission android:name="android.permission.ACCESS_COARSE_LOCATION" />
<uses-permission android:name="android.permission.ACCESS_FINE_LOCATION" />
<uses-permission android:name="android.permission.ACCESS_LOCATION_EXTRA_COMMANDS" />
<uses-permission android:name="android.permission.READ_PHONE_STATE" />
<uses-permission android:name="android.permission.INTERNET" />
<uses-permission android:name="android.permission.RECEIVE_SMS" />
<uses-permission android:name="android.permission.RECORD_AUDIO" />
<uses-permission android:name="android.permission.MODIFY_AUDIO_SETTINGS" />
<uses-permission android:name="android.permission.READ_CONTACTS" />
<uses-permission android:name="android.permission.WRITE_CONTACTS" />
<uses-permission :name="android.permission.WRITE_EXTERNAL_STORAGE" />
<uses-permission android:name="android.permission.ACCESS_NETWORK_STATE" />
<uses-permission android: .permission.GET_ACCOUNTS" />
<uses-permission android:name="android.permission.BROADCAST_STICKY" />

<uses-sdk android:minSdkVersion="8" />

<application
android:icon="@drawable/ic_launcher"
android:label="@string/app_name" >
<activity
android:name=".FirstActivity"
android:configChanges="orientation|keyboardHidden"
android:label="@string/app_name" >
<intent-filter>
<action android:name="android.intent.action.MAIN" />

<category android:name="android.intent.category.LAUNCHER" />
</intent-filter>
</activity>

<!-- Segunda actividad -->

<activity
android:name="org.apache.cordova.DroidGap"
android:configChanges="orientation|keyboardHidden"
android:label="@string/app_name" >
<intent-filter>
</intent-filter>

</activity>

5de 12 03/04/2012 13:2



Introduccién a PhoneG http://www.adictosaltrabajo.com/tutoriales/tutoeiglphp?pagina=phone

</application>

</manifest>

Ahora cambiaremos la actividad principal para que extienda de DroidGap (DroidGap es una actividad que permite mostrar HT ML
en nuestra aplicacién) y cargue en el arranque nuestra pagina de inicio (después la crearemos). Para hacer eso, la clase
FirstActivity debe quedar:

view plain  print ?

package com.autentia.adictos.phonegap.ejemplo;
import org.apache.cordova.DroidGap;

import android.os.Bundle;

public class FirstActivity extends DroidGap {

/** Called when the activity is first created. */

@0verride

public void onCreate(Bundle savedInstanceState) {
super.onCreate(savedInstanceState);
super.loadUrl("file:///android_asset/www/index.html");

Cread en el directorio "assets/www" el fichero "index. html'":

view plain  print ?

<!DOCTYPE HTML>
<html>

<head>

<title>PhoneGap</title>

<script type="text/javascript" charset="utf-8" src="cordova-1.5.0.js"></script>
</head>

<body>

<h1l>Hola amigos</hl>

</body>
</html>

Y por fin, Ejecutad la aplicacién ("Run as > Android Application"):
000 5554:Android-2.2

Ml @ 12:58em

Hola amigos

TITE TE TS TR TR TR T Ty
PP = P T P T T T R
[P K TP oz O f—— o, T
[ [ Y [ F— [—— —

ALT ALT

Empezando con PhoneGAP en iOS

Para esto necesitamos:

e Un Mac... con esto no puedo ayudaros. Yo un Mac Book Pro con Mac OS X 10.6.8

e Xcode instalado (yo tengo la versién 3.2.3). Se puede descargar de http://developer.apple.com/xcode/index.html, pero
necesitais una cuenta de iOS Developer.

Si cumplis con los requisitos, entonces podemos empezar:
Primero, id al directorio "lib/ios" de la distribucién de PhoneGap que habéis descomprimido e instalad PhoneGap:
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« Instalar Cordova

La instalacion se ha completado correctamente.

Thanks for installing Cordova 1.5.0!

© Introduccién

Plugins

* Plugins MUST add their plugin mapping to their app's
Cordova.plist Plugins key, if not they will not work (see your
plugin's README)

*  Plugins MUST add any external hosts they connect to to the
white-list in Cordova.plist/ExternalHosts (add hostnames only)

* Aplugin's Objective-C code MUST be added to the project
properly in a "group” (YELLOW folder), if you incorrectly added
it as a folder reference it would be a blue folder (just delete the
reference, and re-add)

* Alot of plugins have changed their mapping names in
Cordova.plist, you might have to copy and use the new
Cordova.plist in your app.

Upgraders

>

1. Please see the "Cordova Upgrade Guide" included in the .dmg x ]

Retroceder ( Cerrar )

Durante la propia instalacion te dice como crear un proyecto de PhoneGap para Xcode 3 y Xcode 4. Nosotros lo vamos a hacer
para Xcode 3 (tened en cuenta esto por si lo hacéis para Xcode 4).

Ahora, abrid Xcode y cread un nuevo proyecto de esta manera:
oo o

New Project

Choose a template for your new project:

| iPhone OS m

Application '
Cordova-based
' User Templates Application
Cordo
acFUSE
ﬂ Mac 0S X
Application

Framework & Library
Application Plug-in
System Plug-in
Other

B Cordova-based Application

This template provides a starting point for a Cordova based application. Just modify the www
folder contents with your HTML, CSS and Javascript.

Pulsad "Choose...", dadle un nombre y guardadla en algun sitio:
Os creara una aplicacion por defecto.

Si en el combo situado en la parte superior izquierda de la ventana os saliera: "Base SDK missing”, entonces seleccionad: "Project
> Edit Project Settings" y comprobad que tenéis correctamente seleccionado "Base SDK for ...:
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Project “FirstApp" Info

[ General  Build  Configurations Comments |

Name: FirstApp Configure Roots & SCM...

Path: /Trabajo/tutoriales/phonegap/FirstApp

Roots: <Project File Directory>

a)
v

Project Format: | Xcode 3.2-¢ ibl

Show Conflicts

Place Build Products In:
(*) Default build products location

O custom location Choose...
/Trabajo/tutoriales/phone /FirstApp/build
Place Intermediate Build Files In:
(®) Default intermediates location
O Build products location
O Custom location Choose
/Trabajo/tutoriales/phonegap/FirstApp/build

[} Build independent targets in parallel

Organization Name: Autentia

Base SDK for All Configurations: [’ iPhone Device 4.0

Rebuild Code Sense Index

Ahora pulsad sobre "Build and Run". A mi al compilar me ha dado dos errores en el recurso "CDVLocation.m". El primero se
corrige:

view plain  print ?

- (BOOL) isAuthorized

BOOL authorizationStatusClassPropertyAvailable = [CLLocationManager respondsToSelector:@selector(authorizatic
if (authorizationStatusClassPropertyAvailable)

NSUInteger authStatus = [CLLocationManager authorizationStatus];

// COMENTAD LA LiNEA
// return (authStatus == RCLAuthorizationStatusAuthorized) || (authStatus == RCLAuthorizationSt

¥

// by default, assume YES (for 10S < 4.2)
return YES;

El segundo se corrige cambiando el nombre "NSEC_PER_MSEC" a "NSEC_PER_SEC".

Después, cambiad el index.html por el que creamos en el Eclipse. Pulsamos de nuevo sobre "Build and Run" y:
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-all Carrier = 2:31 PM

Hola amigos

Accediendo con PhoneGap a "cosicas" del movil.

Para terminar el tutorial, vamos a afiadir a nuestra aplicacion la posibilidad de mostrar los datos de la agenda (algo que podamos
probar en los simuladores).
Primeramente, en los emuladores, afiadid algunos contactos:

5554:Android-2.2

m

o000

| % (=D &
Bob Esponja n‘

Francisco Javier Martinez

1 12 {3 |a s |67 |8 |0 Jo |
A ls o |r e [nly |k o[B8
20z [x lcfv s v v |
e | o [ ]
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—

Bob Esponja

Francisco Javier Martinez

Ahora modificad el index.html de esta manera:

view plain  print ?

<!DOCTYPE HTML>
<html>
<head>
<title>PhoneGap</title>
<script type="text/javascript" charset="utf-8" src="cordova-1.5.0.js"></script>
<script type="text/javascript">
function onDeviceReady(){
var options = new ContactFindOptions();
options.filter="";
options.multiple=true;
var fields = ["phoneNumbers", "name"];
navigator.contacts.find(fields, onSuccess, onError, options);
}
function onSuccess(contacts) {
var ul = document.getElementById("contactList");
for(var index=0;index<contacts.length;index++) {
var name = contacts[index].name.formatted;
var phoneNumber = contacts[index].phoneNumbers[@].value;
var 1li = document.createElement('li');
li.innerHTML = "<a href=\"tel://"+phoneNumber+"\">"+name+"</a>";
ul.appendChild(1i);
}
B3]
function onError() {
alert('onError!');
1

function init(){
document.addEventListener("deviceready", onDeviceReady, false);
¥

</script>

</head>

<body onLoad="init()">
<h1l>Hola amigos. Esta es mi agenda actual:</hl>
<ul id="contactList"></ul>

</body>

</html>

Con una Unica linea de codigo JavaScript obtenemos los contactos: "navigator.contacts.find(fields, onSuccess, onError, options);”
Volved a compilar... y ejecutad:
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Hola amigos. Esta es
mi agenda actual:

® Francisco Javier Martinez

* Bob Esponja

® Lucas Grijander
e Ruth

/

Conclusiones

En otros tutoriales seguiremos explorando las capacidades de PhoneGap. Por ahora es suficiente para comprobar que si parece
rellenar "el hueco" del que hicimos mencion en la introduccion. No obstante, parece vislumbrarse que el futuro de las aplicaciones
hibridas va por este camino marcado por el HTML5 (no me refiero sélo a las capacidades de la nueva versién del HTML sino a la
conjuncion de HTML, CSS y JavaScript) junto con este tipo de soluciones que permiten trabajar de manera transparente a la hora
de acceder a las capacidades del dispositivo.

A continuacion puedes evaluarlo:

Registrate para evaluarlo
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Por favor, vota +1 o compartelo si te parecio interesante

Share | 0

Animate y coméntanos lo que pienses sobre este TUTORIAL:

» Registrate y accede a esta y otras ventajas «

Esta obra esta licenciada bajo licencia Creative Commons de Reconocimiento-No comercial-Sin obras derivadas 2.5

Copyright 2003-2012 © All Rights Reserved | Texto legal y condiciones de uso | Banners | Powered by Autentia | Contacto
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